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1. About This Guide

1.1. Who Should Use [t

This user guide is intended to provide Defense Logistics Agency (DLA) personnel with
instructions and operational procedures to connect to the DLA network via Citrix, using non-
Government-Furnished Equipment (non-GFE). Non-GFE includes both Contractor-Furnished

Equipment (CFE) and personal equipment (i.e., home computer).

Risks

There are potential risks associated with installing prerequisite software components (i.e.,
ActivClient, Citrix Receiver, DOD Root Certificates) and using the remote access system. It is
not possible to test these components with all software and/or applications thatare
commercially available and that may be on your home computer. Therefore, it is possible that
the prerequisite software components could conflict with other applications or software residing
on your home computer. Use of this capability on your personal non-Government-furnished

computer is at your own risk.

Disclaimer of Liability

With respect to installing prerequisite software components or using the remote access solution,
neither the DOD, DLA, nor any employees within, provide any warranty, expressed or implied,
or assume any legal or financial liability or responsibility for your non-Government computer
system and/or damages or repairs that may result from system incompatibilities with the remote
access solution. By installing prerequisite software and using this product, you signify your
agreement to the preceding terms and conditions. If you do not agree to these terms and

conditions, do not install or use this product.
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2. Citrix — Introduction

2.1. Overview

Citrix provides a secure means of teleworking using a remote user’s personal or contractor-
furnished computer. Citrix contains security configurations to preventaccess to the user’s local
storage devices (i.e., hard drives and flash drives). Users connect to Citrix via their Web
browser, enabling easy and secure access to available DLA applications as only keystrokes,
mouse clicks, and display images are transmitted over an encrypted connection between the

client computer and the Citrix environment.

2.2. Hardware and Software Required

Personal or contractor-furnished devices running on Windows XP, Windows Vista, Windows 7,
Windows 8/8.1 or the latest versions of Mac OS can be used via the processes described in
this document. The table belowis a breakdown of all browser/operating system combinations
that are supported by Citrix. It is highly recommended to use one of these combinations, as

deviation could result in performance issues or inability to connect.

Browser Operating system

Internet Explorer 11.x or later Windows 8.1 64-bit Editions

(32-bit mode) Windows 8.1 32-bit Editions
Note: Please refer to Windows 7 Service Pack 1(SP1) 64-bit Editions
Appendix G for details Windows 7 Service Pack 1(SP1) 32-bit Editions
Internet Explorer 10.x or later HiEleAE - Eambil [E81ens
(32-bit mode) Windows 8 32-bit Editions

Windows 7 Service Pack 1(SP1) 64-bit Editions

Windows 7 Service Pack 1(SP1) 32-bit Editions

Windows 7 64-bit or higher
Windows 7 32-bit or higher

Internet Explorer 9.x or later

(32-bit mode)
Windows Vista 32-bit Editions with Service Pack 2

Windows Vista 64-bit Editions with Service Pack 2

Citrix Home User Guide Page 4



Browser Operating system

Internet Explorer 8.x Windows 7 64-bit Editions

(32-bit mode) Windows 7 32-bit Editions
Windows XP Professional with Service Pack 3
Windows XP Professional x64 Edition with Service Pack 2
Windows Vista 32-bit Editions with Service Pack 2
Windows Vista 64-bit Editions with Service Pack 2

Safari 5.x Mac OS X Snow Leopard 10.6
Safari 4.x Mac OS X Leopard 10.5
Mozilla Firefox 4.x Windows 7 64-bit Editions
(32-bit mode) Windows 7 32-bit Editions

Windows XP Professional with Service Pack 3

Windows XP Professional x64 Edition with Service Pack 2
Windows Vista 32-bit Editions with Service Pack 2
Windows Vista 64-bit Editions with Service Pack 2

Mozilla Firefox 3.x Mac OS X Snow Leopard 10.6
Mac OS X Leopard 10.5
Windows XP Professional x32 Edition with Service Pack 3
Windows Vista 32-bit Editions with Service Pack 2
Windows 7 32-bit Editions
Red Hat Enterprise Linux 5.4 Desktop

Additionally, there are three software components that are required in order to use Citrix -
these are documented in Section 3 of this document.

Lastly, it is highly recommended that you use a high speed Internet connection, as opposed
to dial-up or satellite.

2.3. Help Desk Support

All liability for issues and troubleshooting non-GFE lies with the end user. The DLA Help Desk
will not provide support for issues with hardware/software not provided by DLA, including but
not limited to non-GFE hardware, non-DLA networks (e.g., home routers, public hot spots), ,
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and non-DLA software compatibility issues with Citrix.

DLA Help Desk resources will support troubleshooting issues that are not related to the non-
GFE hardware/software, including but not limited to accounts, DLA applications, and server-

side issues.

2.4. Home Use Printing

Home Use printing to your local printer is restricted by a DOD Security Policy and is therefore
prohibited.
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3. Pre-connection and Configuration Activities

Before connecting to Citrix for the first time, certificates and client software, available on the
DLA Enterprise Remote Access log-in page, need to be installed, followed by a machine
reboot. This process is described in the following steps:
1. Connect your Common Access Card (CAC) Reader to an available USB Port on your
Personal Computer System (Desktop/Laptop)
Turn on Personal Computer System (Desktop/Laptop).
Launch Internet Explorer V.7 or higher
4. Validate that required security protocols are enabled:

From Internet Explorer, select Tools and Internet Options

§ Orterve Loginics

(" orecrons]]
AGENCY ?-ﬁmaugm

R AGENCY A s "y’ 201
AR ekl
fosem e S
Prvacy

Busness Operatons = | Carvers = | Dreciory | FOW

e eNcY
Hotline Program
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When the Internet Options window appears select the Advanced tab and ensure Use SSL
3.0 and Use TLS 1.0 are checked in the Security section.

‘ General I Security | Privacy | Content | Connections | Programs | Advanced

Settings

Enable DOM Storage -
[ Enable Integrated Windows Authentication®

Enable memary protection to help mitigate online attacks™
Enable native XMLHTTP support

Enable SmartScreen Filter

L’ Use 55L 3.0
N Use TLS 1.0

[[] useTis 1.2

Warn about certificate address mismatch® b
[ Warn if changing between secure and not secure mode |E ‘
Warn if POST submittal is redirected to a zone that doesnl

| 1 | +

Takes effect after you restart Intemet Explorer

Restore advanced settings
Reset Internet Explorer settings
Resets Internet Explorer's settings to their default
condition. =

You should only use this if your browser s in an unusable state.

-@ Some settings are managed by oy system administrator.
Do ][

Once these protocols are checked, click OK, close your Internet browser, and open a new

Internet browser window.

Insert DLA CAC into CAC Reader

In your Internet browser, navigate to the DLA Enterprise Remote Access login page (URL
below) to access pre- requisite files for download. Note that regardless of which DLA field
site you are assigned to, everyone should obtain these files from this site.

Type the following URL and click Enter
https://remote.dla.mil

The first time navigating to this page, the user may see a warning message similar to the
Web site below. If this appears, select Continue to this Web site (notrecommended)

e e e — =
—— it aritnee g

0\ il £ hepe Yorbehor ctrihg damid
k& Fovostes 4 0 Home - 158 Suppont S

£ Cenicane Ensr: Novvgation Blecked N8 - v Pagev Sefetyv Teckiv @i
g a pre with ¢ website

We recommend (hal you (e Iha webpage and do nl contome 1o o welnte

2
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7. Select the | Agree with the Statements Abov e button

» pEFENSE Loel’"ﬂ'lcs AGENCY,

The w.mgm-rs gimcs Combat Support Agency.

You are accessing a U.S. Government (USG) Information System (I3) that is provided for USG-authorized
use only.

By using this IS (which includes any device attached to this IS), you consent to the following conditions:

-The USG routinely intercepts and monitors communications on this 1S for purposes including, but not limited
to. penetration testing, COMSEC monitoring, network operations and defense, personnel misconduct (PM),
law enforcement (LE), and counterintelligence (Cl) investigations.

-At any time, the USG may inspect and seize data stored on this IS.

-Communications using, or data stored on, this IS are not private, are subject to routine monitoring,
interception, and search, and may be disclosed or used for any USG-authorized purpose.

-This IS includes security measures (e.g., authentication and access controls) to protect USG interests—not
for your personal benefit or privacy.

-Motwithstanding the above, using this IS does not constitute consent to PM, LE, or Cl investigative
searching or monitoring of the content of privileged communications, or work product, related to personal
representation or services by attorneys, psychotherapists, or clergy, and their assistants. Such
communication and war private and con - ser Agreement for details.

| | Agree With The Statements Above | DI Disagree

8. On the screen belowyou will see two links for components that need to be installed prior
to establishing a connection to Citrix from each machine for the first time:

_pEFENSE LOG ISTICS AG ENCY

The Warlighiers ?ﬂ-’cﬁ Combal Support Agency.

DLA Enterprise Remote Access System

| Eu/Afr Login | LOGIN | Pacific Login |

Note: VDI LOGIN will be available to Phase 1 VDI users only

VDI LOGIN

If this is your fi f'rst time accessing this system from this machine, you may need to
install ths gt log in:

+« DoD Root Certificates
o Windows
o Mac 0S
e Citrix Receiver
o Windows
o Mac 0S5

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.252.0001
to request the software and a CAC reader.
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Select DOD Root Certificates -> Windows and select Sav e when prompted. Save this
file to your computer, and after download is complete, locate file, right click on file, and
select Run as Administrator. This exe file will install all required DOD Certificates to the
appropriate location on your machine. These certificates are required to be installed on a
machine when using a CAC. You may see two prompts issuing a security warning.
These warnings are standard, and if you accept them, you should click Yes on both.
Note that clicking No will prevent the machine from using Citrix.

5
Security Waming | = |

You are about to install a certificate from a certification authority (CA)
I . claiming to represent:

You are about to install a certificate from a certification authority (CA)
! % claiming to represent:

dod ocsp ss
DoD Root CA2

Windows cannot validate that the certificate is actually frem "dod ocsp
ss ", You should confirm its erigin by contacting "dod ocsp ss ™. The
following number will assist you in this process:

Windows cannot validate that the certificate is actually from "DeD Root
CA2". You should confirm its origin by contacting "DoD Root CA 2",
The following number will assist you in this process:

Thumbprint (shal): 8C941B34 EATEABED 9AE2BCS4 CFB87252 B4CIBS61

Warning:
If you install this root certificate, Windows will automatically trust any
certificate issued by this CA, Installing a certificate with an unconfirmed

Thumbprint {shal): 4F46A0EE COFG6BF4 A424D5B2 93EE2B0B 905098CD

Warning:
If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed

thumbprint is a security risk. f you click "Ves" you acknowledge this thumbprint is a security risk. If you click "Yes" you acknowledge this
risk., risk,

Do you want to install this certificate? Do you want to install this certificate?

Euw/Afr Login

Pacific Login

Note: VDI LOGIN will be available to Phase 1 VDI users only

VDI LOGIN

If this is your first time accessing this system from this machine, you may need to
install the following to log in:

+ DoD Root Certificates
o Windows
0

IErix Reoelver
o Windows
o Mac O

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.352.0001
to request the software and a CAC reader.
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The Citrix Reciever is required to establish a secure connection with Citrix. This client
supports Mac, Windows XP, Vista, Windows 7/8/8.1 operating systems. When prompted,

run the file and accept all defaults.

10. Request latest version of ActivClient to your local IT Support Staff. Note there are two
choices of ActivClient to install, which is based on the configuration of your operating
system:

- 32-Bit
* 64-Bit

You can verify the version of your operating system by right-clicking the My Computer icon on
your Desktop, and selecting Properties.

i Computer

A A

1\_)1\_) |;‘.i ~ Computer -

Organize *  System properties  Uninstall or change a program  Map network drive Open Control Panel

B 9r Favorites + Hard Disk Drives (1)
B Deskiop - osDisk (C:)
4. Downloads L I
. = 153 GB free of 232 GB
j=1l Recent Places
+ Devices with Removable Storage (1)
== Libraries - 5D Disk (D:)
“:| Documents
Jv 156 MEB free of 968 MB
,J. Music
(& Pictures
E Videos
= ﬁ Computer
Collapse

S osbisk (C:)
B sDDisk (D) | ) Manage
Open in new window
'Eh MNetwork Scan using Spybot-Search&Destroy

Map network drive...
Disconnect network drive...

Add a network location

Delete
Rename

< Properties >

On the Screen that appears, it should state 32-bit or 64-bit Operating System.
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il Control Panel\System and Security\System

=0l

CK) Lu;l - Control Panel - System and Security - System

- m I Search Control Panel

Control Panel Home

'Sl Device Manager
'@l Remote settings
f@' System protection

’@l Advanced system settings

See also
Action Center
Windows Update

Performance Information and
Tools

View basic information about your computer

Windows edition

Gl

Windows 7 Enterprise
Copyright © 2009 Microsoft Corporation. Al rights reserved.

Service Pack 1
System
Manufacturer: CIO Technology Services
Model: MPCWin7 November 2011
Rating: Windows Experience Index
Processor: Intel(R) Core(TM) i5-2410M CPU @ 2.30GHz 2.30 GHz
Installed memory (RAM):
System type:

Pen and Touch:

CIO Technology Services support

Website: Online support

Computer name, domain, and workgroup settings
Computer name:
Full computer name:
Computer description:

Domain:

Windows activation

[EChange settings

Windows is activated

Product ID: Change product key

Learn more online. ..
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When prompted, run the install file and accept all defaults:

Internet Explorer - Security Warning [—x

The publisher could not be verified. Are you sure you want to run this
software?

Name: ActivClisnt_6.2_x32.EXE

Publisher: Unknown Publisher

i % | This file does not have & valid digital signature that verifies its publisher. You
@ should only run software from publishers you trust. How can I decide what
W software to run?

11. Reboot the computer after all prerequisite components have been installed.

4. Establishing a Citrix Connection

Note: Specific screenshots and images throughout this document may differ from site to site

The following steps detail the process for connecting to Citrix and launching applications

once the prerequisite steps in Section 3 have been addressed.

1. Connect your Common Access Card (CAC) Reader to an available USB Port on your
Personal Computer System (Desktop/Laptop)

2. Turn on Personal Computer System (Desktop/Laptop).

3. Launch Internet Explorer V.7 or higher

4. As an alternative to https://remote.dla.mil, the following URL addresses can be accessed as
listed below:

If you work at this DLA Site Use this URL
Headquarters https://fortbelvoir.citrix.hg.dla.mil
Aviation https://rmt.aviation.dla.mil

Land and Maritime, Transactior] https://remotec.dla.mil

Services, Logistics

Information Services

Troop Support, Information https://pubctx.troopsupport.dla.mil
Operations Ogden, Document

Services

Europe & Africa https://wwc.europe.dla.mil
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Pacific

https://remote.pacific.dla.mil/

Distribution

https://rmt.distribution.dla.mil

Click “Continue to the Website”

Type the URL, and click Enter

Note: Some users may not be required to complete steps 5 and 6 due to site-specific

Citrix configuration
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5. Select the | Agree With the Statements Abov e button

DEFENSE LOGISTICS AGENCY

The Wartighters Weylslics Combat Support Agency

iﬁll.lhllll"

You are accessing a U.S. Government (USG) Information System (IS) that is provided for USG-authorized
use only.

By using this IS (which includes any device attached to this IS), you consent to the following conditions:

-The USG routinely intercepts and monitors communications on this IS for purposes including, but not limited
to, penetration testing, COMSEC monitoring, network operations and defense, personnel misconduct (PM),
law enforcement (LE). and counterintelligence (Cl) investigations.

-At any time, the USG may inspect and seize data stored on this IS.

-Communications using, or data stored on, this IS are not private, are subject to routine monitoring,
interception, and search, and may be disclosed or used for any USG-authorized purpose.

-This IS includes security measures (e.g.. authentication and access controls) to protect USG interests—not
for your personal benefit or privacy.

-Motwithstanding the above. using this IS does not constitute consent to PM, LE, or Cl investigative
searching or monitoring of the content of privileged communications, or work product, related to personal
representation or sewvices by attorneys, psychotherapists, or clergy, and their assistants. Such
communication and work : User Agreement for details.

H\I Disagree

| Agree With The Statements Above
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6. Select DLA Enterprise Remote Access System location

1. For CONUS Users , Select Login link (Note: select the login link where you are
based — which may be away from your normal location)

. S

-}pEFENSE LOG fﬁ'lcs AGENCY

The Warfigh.!ars g?.ﬂh'.s Combal Suppori Agency.

|1|Il|l

| EulAfr Login

| Pacific Login |

Note: VDI LOGIN will be available to Phase 1 VDI users only

VDI LOGIN
If this is your first time accessing this system from this machine, you may need to
install the following to log in:

+« DoD Root Certificates
o Windows
o Mac Q5
« Citrix Receiver
o Windows
o Mac 05

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.352.0001
to request the software and a CAC reader.
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2. For OCONUS Users, Select Eu/Afr Login or Pacific Login link (Note: select the
login link where you are based — which may be away from your normal location)

e S ——

g - -}pEFENSE LOGI’ﬂulcs AGENCY
L T .

The Warﬂgh.!ars g?.ﬂh'.s Combal Support Agency

(L1

DLA Enterprise Remote Access System

Eu/Afr Login ) | LOGIN Pacific Login )|

Note: VDI LOGIN will be available to Phase 1 VDI users only

VDI LOGIN

If this is your first time accessing this system from this machine, you may need to
install the following to log in:

« DoD Root Certificates
o Windows
o Mac 05
s Citrix Receiver
o Windows
o Mac OS5

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.352.0001
to request the software and a CAC reader.
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7. When prompted select your DOD EMAIL certificate and click OK
Windows XP:

Choose a digital certificate

Identification

' The website you want to view requests identification,
¥\ Please choose a certificate.

Hame Issuer

DOD EMAIL CA-25
DOD CA-25

[ More Info... ] [Vlew CErtlflcatE...]

Windows Vista:

Choase a digital certificate (% [meie]

Identification

The website you want to view requests identification.
B\, Please choose a certficate.

Name Issuer
DOD EMAIL CA-25
DOD CA-25

[ More Infa... ][mewcam‘ﬁmte..‘]

Cancel

Windows 7:

Select a Certificate

Issuer: DOD CA-25
Valid From: 2/17/2011 to 3/29/2012

Issuer: DOD EMAIL CA-25
Valid From: 2/17/2011 to 3/29/2012

iClick here to view. certificate prope....

Windows 8/ Windows 8.1:
[ WindowsSeariy S

Select a Certificate

Issuer: DOD EMAIL CA-31
Valid From: 9/18/2013 to 3/31/2014

properties

Issuer: DOD CA-31

Valid From: 9/18/2013 to 3/31/2014

[ ox Cancel
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Mac OS:

\ The webdsite “fortbelvoir.citrixccl Lhqdlamil” requires a client
i“a certificate.

@ This website reqwires 3 Certcate 1o validate your dentty. Sefect the
— Certficate 10 use when you CONMeCt 10 This website, and then chick
Comerue.

& C A
KX sz
gc MAZL CA-2

i?) Show Certificate Cancel | | Continue

8. When prompted type your CAC
PIN: Windows XP:

ActivClient Login

Actividentity

ActivClient

Please enter your PIN,

PIN I

OK I Cancel

Windows Vista:

ActivClient Login (P [t

Actividentity

ActivClient

Please enter your PIN.

PIN [1

OK I Cancel

Windows 7:

Windows Security x|

Microsoft Smart Card Provider
Please enter your PIN,

PIN

PIN

Click here for more information

Citrix Home User Guide Page 19



Windows 8/ Windows 8.1: ‘

[t Eogin (D [z
3 ¢ Smart Card
Actividentity Please ener your PIN,
ActivClient
PIN
Please enter your PIN.
[on
PIN I
- : : .
s Cancel
Mac OS:
- WebProcess wansts 10 use the ‘i
N o r
L e
Feste erter the heyehain passmond.
Password --a-c-4 ]
2 Cancel | [OK
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9. The next screen that appears will be the CITRIX Application window.

(Note: The icons you see upon logging in may differ from those shown
below)

= DLA Enterprise Remeote Access

Applications Desitops
Main L Select view: v
‘[.- ] e ] = ] - ] (i ] = ] @ ]
ARIS DLA Links ERwIn DM MS Office 2010 Old Java Apps Old Java Apps SAP GUI
1747
) = ] P ) [_)_ J d (e Py
i~ -t | £ 2
SsL20 Utills Web Apps Adobe X Excel 2010 internet Explorer 8 Microsoft Project
2010
2 Py 2 =) oc P4l (8
AT =i 4= | AL #
Microsoft Visio MS Project 2010 MS Visio 2010 (o413 QUTLOOK 2010 PowerPoint 2010 QMF
2010

LS ) = wi

RDP Client SAP GUI Windows Explorer Word 2010

10. To launch an application, single (left) click on the icon for the program you wish to launch.

When prompted, select your Certificate and enter your PIN.
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11. To Logoff, click on the Log Off in the upper right corner. The Web portal will log you

off automatically after 20 minutes of the page being inactive. This does NOT log you
out of your Citrix Session.

Applications

£

ARIS

[l

ssL20

Microsoft Visio
2010

RDP Client

Citrix Home User Guide

(il

Desktops

£
DLA Links

B

ERwiIn DM

£ ot

Utils Web Apps
(pd v:l
P V%

MS Project 2010 MS Visio 2010

2
o
SAP GUI Windows Explorer

DLA Enterprise Remote Access

=

MS Office 2010

[~

Adobe X

ocs

Word 2010

C-‘_]

Old Java Apps

Excel 2010

07

OUTLOOK 2010

&)

Old Java Apps
1717

e

internet Explorer 8

PowerPoint 2010

Microsoft Project
2010
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Appendix A — Setting up Microsoft Outlook in Citrix

First-time Outlook Setup

1. If, after launching Outlook, you're presented with the following message box, you will need to
configure (or reconfigure) Outlook. Click Next and followthe instructions belowto create all of
your Outlook settings that will allow you to connect to the email server and download your mail.

Microsoft Outlook 2010 5 n r

Microsoft Outlook 2010 Startup

Welcome to the Microsoft Outlook 2010 Startup Wizard, which will guide you through the
process of configuring Microsoft Outlook 2010,

e,
= Back. ‘ Mext = h Cancel
AN Z
e
2. Select Yes and click Next:
Account Configuration X I
E-mail Accounts
‘fou can configure Outlook to connect to Internet E-mail, Microsoft Exchange, or
other E-mail server. Would you like to configure an E-mail account?
% Yes
 No
Pt N
< Back ( MNext = b Cancel
LY 2
—
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3. Select “Manually configure server settings or additional servertypes’. Click Next

Add Mew Account

Auto Account Setup
Connect to other server types.

¢ E-mail Account

Your Mame: II our name should appear here

Example: Ellen &dams

E-rnaill sddress: It"::uur email address should appear here

Example: ellen@contosa, com

" Text Messaging (SMS)

(= Manually configure server settings or additional server types

4. Select “Microsoft Exchange or compatable service”. Click Next

(Add New Account

Choose Service

" Internet E-mail

Connect to POP or IMAP server to send and receive e-mail messages.
% Microsoft Exchange or compatible service

Connect and access e-mail messages, calendar, contacts, faxes and voice mail messages.
" Text Messaging (SMS)

Connect to a mobile messaging service.

< Back ( I Mext = I ) Cancel
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5. Your Server and User Name may (or may not) be auto-populated in the next panel of the wizard.
If these values are auto-populated correctly, click Check Name.

If the server field is blank, you will need to call your Help Desk and ask them for your Exchange
server name. Theymay need to knowwhat DLA location you work at and possibly what domain
you are associated with, if that information is available.

Add New Account

Server Settings
Enter the information required to connect to Microsoft Exchange or a compatible service.

Type the server name for your account. If you don't know the server name, ask your
account provider.

Server: || Enter Exchange server name here
™ lse Cached Exchange Mode

Type the user name for your account,

User Name: | Your user name will appear here Check ame |

More Settings ... |
e

< Back ‘ Next = D Cancel |
et

After you click Check Name, you should be able to click Next and move on to Step 6.

Sometimes a different windowthan the one shown above appears and the Serverfield is not
initially blank and instead contains a string of text as shown here::

Microsoft Exchange m |

General |

Microsoft Exchange server:
ILI SE 3/cr=Configuration/cn=5ervers/cn=BE LOSGEMON4

Mailbo:

Iyuur name will appear here Chedk Mame |

Once the names have been checked and are underlined,
dick Ok,

QK I Cancel apply
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If you see a string of text such as this, you will need to delete all extraneous characters to the left
of the Exchange server name, shown in red below.

=USE3/cn=Configuration/cn=Servers/chn=BELOSGMO004
Using the example above, the remaining text in the Server box would be:

BELOSGMO004
(NOTE: this is from the example, it may or may not be your mail server name)

Once the Exchange server name and your user name have been entered, click Check Name.
After you click Check Name, the server name should be replaced with another longer string of
text that may look as follows:

BELOSGEMO004.AD.DLA.MIL
You may now click OK.

6. Your Outlook Profile should nowbe created. Click Finished

Add New Account

Congratulations!
‘fou have successfully entered all the information reguired to setup your account.

To dose the wizard, dick Finish,

-
A Add another account... |
. —

Adding a Personal Folder (i.e., PSTfile) to your Outlook profile

1. Open Outlook through Citrix.
2. On the File menu, select Open, and then select Outlook DataFile.

3. Select your U: drive from the drop-down menu.
*Distribution and J6N users select H: drive and the “outlookpst” folder.

4. Double-click the .PST file that you want to open, and then click OK (you may have to
navigate through your subfolders to find the appropriate file).
5. Your .PST file should now be listed in your Outlook window.
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How to add an Outlook Auto Signature to your Outlook profile
1. Openanew message. Onthe Message tab, in the Include group, click Signature, and then
click Signatures.

Q g [ %9 | Follow
—J ¥ HighIm
Attach Attach |Signature

R | 4 LowImp
Includy Signatures... hi

On the E-mail Signature tab, click New.
Type a name for the signature, and then click OK.

In the Edit signature box, type the text that you want to include in the signature.

o M 0N

To format the text, select the text, and then use the style and formatting buttons to select the
options that you want.

6. To add elements besides text, click where you want the element to appear, and then do any of
the following:

OPTIONS HOW TO

To add an electronic Click Business Card, and then click a contact in the Filed As list. Then click OK
business card

T h link ) ) . : ) ) ’ . .
0 add a hy periin Click %Insert Hyperlink, ty pe in the information or browse to a hy perlink, click to select it, and then click OK

To add a picture ) ) ) ) ) ) ) ) .
P Click E:Hcture, browse to a picture, click to select it, and then click OK. Common image file formats for pictures

include .bmp, .gif, .jpg, and .png.

7. Tofinish creating the signature, click OK.

NOTE The signature that you just created or modified won't appear in the open
message; it must be inserted into the message.
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Appendix B — Tips and Common Error Solutions

1. If the following screen appears, preventing the user from selecting their certificate and
logging in, all browser sessions should be closed. Upon logging in with a new browser

session, the issue should be resolved.

Log on

_ e

' ‘ Lizar ramn 2 —]
N

Seanion | —I

Lomazin:

X Anauthentiationeror cccurred, Please ckezall
browesers, re-open your broweser and confirm you
anesskecting your Dol EMAIL certifiats.

Logon...

2. Occasionally in circumstances involving slow connectivity, Citrix applications may not
immediately respond to attempts to launch applications. In this scenario users should
refrain from repeatedly clicking the applicationicon as this will cause the application to
‘queue up’ multiple instances that will all begin launching, negatively impacting Citrix
performance. If after waiting at least 30 seconds, an application does not launch or has
appeared to fail during launch, then at that point click on the application’s icon again as
this may result in it launching properly. Users should also note thatresponsiveness and
performance of the Citrix application should improve after the initial connection is
established and the application launches.
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3. If you see a Windows Server account lock screen and you are no longer using Citrix,
this screen can be closed by right clicking the Citrix Connection Center icon onyour

System Tray and selecting Open Connection Center.

EMWE& 9SS AM
o O ®LI[ 0 a1 () o

When the Citrix Connection Center Window appears, click the Disconnect button. This

will close your Citrix session and Windows Server lock screen.

i1
— ICA connections
=25 Active <
=& [BELIS

=10 Inbox - :

----- 0| Microsoft Outlock - Motfication lcon

inl=] You have new unread e-mail message Properties

Log Cff
— Session Securty —————
Files:
I.ﬁsk Pemission j
Microphones MW ebcams:
I.F'usk Pemission j
PDA Devices:
I.-'-‘»sl-: Permission j
|USB/Cther Devices:
Iﬂsk Permission j
— Application
P | | ﬂ Terminate
1 Server used, 3 Remote Applications Help
Close
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4.

¥ Citrix XenApp - Applications - Windows Internet Explorer

If you are using Internet Explorer version 9, and you receive the following prompt, you can
click “Open” or remove this prompt from appearing again by completing the following steps:

[_[E]x]
i + i M E i y
&) = [B st damicirsgcncicteiscra O] 8] ][44 % || @ coenenson -rieaters. o 1y i
[ B B B B B (58]
ADP Security Base Wide DLA Applications DLA Links DLA Web Links DOD User External DLA Users
Applications Agreement
B B B B B (= (]
Microsoft Office Microsoft Office MS Office 2007 MS Office 2010 sap SAP GUI Software
2007 2010
= = = (3
Test Apps Utils Web Apps Adobe Acrobat Pro Adobe X DRU System Excel 2010
aal = =) p p
e A L oz, P P wE
L 5 5 5 J)
Internet Explorer & MS Excel 2010 MS OneMote 2010 MS Qutiook 2010 MS PowerPoint MS Pulisher 2010 MS Word 2010
2010
= ] Ly (=]
o [
125 L :
ocs OUTLOOK 2010 PowerPoint 2010 ROP Ciient Remedy 76 SAP GUI 72 Windews Explarer
Weord 2010 WordPad-24
‘ Do you want to open or save launch.ica (1.45 KB) from gsib.dla.mil? Open Save |v| Cancel | x _|

Open Internet Options:

Applications

Desktops

Your session wil expire in less than a minute, If you need more time, click more time required.

B

ADP Security

B

Microsoft Office
2007

(o8]

Test Apps

e

Internet Explarer 8

Base Wide
Applications

B

Microsoft Office
2010

(o8]

Utils

MS Excel 2010

(]

DLA Appiications

(]

MS Office 2007

B

Web Apps

LB,

MS OneNote 2010

(]

DLA Links

[

Ms Office 2010

=

Adobe Acrobat Pro

ot

MS Outlook 2010

o

DLA Web Links

Adobe X

3

MS PowerPoint
2010

DOD User
Agresment

DRU System

3

MS Publisher 2010

Remote Act

*ﬁu

Fille:
Zoom (100%:) 3
Safety 3

Viewt downloads Ctrl+]
Manage add-ons

F12 developer tools

Internet options
s tats xplarer

Select view: ¥
(]

External DLA Users

B

Software

LS

Excel 2010

(Wi

MS Werd 2010

‘ Do you want to open or save launch.ica (1.45 KB) from gslb.dla.mil?

Open |

s |=0 cos [

-

Click Security:

a Y
& [ sanieniz =
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| © Citrix Xenfipp - Applications X

= DLA Enterprise Remeote Access

@ Ta create home page tabs, type each address on its own line,
I =l

Lse current Lse defaul Useblank |

Browsing history

N a minute, If you need more time, click more time required.
T, et temporary files, histary, cookies, saved passwords,
"1 and web Farm information.

Select view:
™ Delets browsing history on exit L—J
Delete. Settings j @ @ @ @

Search
ide DLA Applications DLA Links DLA Web Links DOD User External DLA Users
Change search dafaults. Settings tions Agreement

Tahs

| Change how webpagss are displayed in Settings

= il B B B B B
Appearance It Office M Office 2007 MS Office 2010 SAP SAP GUL Software

0
Coors | Languages | Fonts | accessbity |

C o ] ol | o |[) B oy (= | |

e . Web Apps Adobe Acrobst Pro Adibe X DRU System Excel 2010

PJ
Internet Explorer & M5 Excel 2010 MS OneNote 2010 MS OQutlook 2010 MS PowerPoint M5 Publisher 2010 MS Word 2010
2010

Cancel

ﬂl il E 5 I@ & [ sianfzpnr:z

Gitriz XenApp - Applications X

= DLA Enterprise Remaote Access

Internet Local intrane| Restriched

Trusted sites

This z61e cantains webs
"% trustnot to damage your
your files.

Select vi b
Security lewel For this 2one view:

Allowsed levels For this 2one: Al

s ) = & £ &

- c;n'fgr'"ils leeFaredlen it ity une ide DLA Applications DLA Links DLA Web Links DOD User External DLA Users
‘I": ~ Unsigned ActiveXt controls will ot be downloaded Hons Agreement

or n & minute, If you need more time, click more time required.

[~ Enable Pratected Mode {requires restarting Internet Explorer)

customlevel... | Defaultled | j @ @ @ @ @

[ Office MS Office 2007 MS Office 2010 SAP SAP GUI Software

Reset &l lzones ko default [eve] 0

Lo ] ol | o [[) B oy (= |

e : Web Apps Adobe Acrobst Pro Agobe X DRU System Excel 2010

e LS 05 (Wi

Internet Explorer & M5 Excel 2010 MS OneNote 2010 MS Qutlook 2010 MS PowerPaint MS Publisher 2010 MS Werd 2010
2010

Do you want to open or save launch.ica (1.45 KB) from gslb.dla.mil? Open Save | ¥ Cancel x

EI il E m% I@ & [0 5:30:2?:2
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Click “Add” to add this web site then “Close”:
i -

A5 Citrin X
t Internet Op

Trusted sites [ =] L |

You can add and remove websites From this zone. All websites in
this zone will use the zone’s security settings.

T this website to :
[hetps:figsto.dia.mi [ nad |

RemoyE n a minute. If you need more time, click more time required.

© citrix enpp - Applications X

DLA Enterprise Remote Access

(seaaven: - |
¥ Requiv server verification [https:] For all stes in this aoms 0 @ @ Ej @ @

ide DLA Applications DLA Links DLA Web Links DOD User External DLA Users

Close tions Agreement
I Enable Protected Mode (requires restarting Inkernet Explorer)
custombevel. | oeratievs || | [
|t Office MS Office 2007 MS Office 2010 SAP SAP GUI Software
Reset al zones o defaut level o

o

Web Apps Adobe Acrobat Pro Adobe X DRU System Excel 2010

Ok | Cancel | Aaply |j

T " al

.

e 05 [PS (W

Internet Explorer 8 M5 Excel 2010 MS OneNote 2010 M5 Outlock 2010 MS PowerPoint MS Publisher 2010 MS Werd 2010
2010

Open Save Cancel

4:05 PM

ﬂl él E & I@ * IFb E I(l' 5/30/2012

‘Custom Level”:

Select*
FI -t - ‘

(Genersl Security | privacy | Content | Comnections | Programs | Advanced |

© citrix enpp - Applications X

DLA Enterprise Remote Access

Select a 2one bo view of change security settings.

¢ & v O

Internet Localintranet  Trusted sites  Restricted
sibes

Trusted sites
J This zone contains websites that you

trust not to damage your computer or
your files.

You have websites in this 2one.
Select views ¥

~Security level for this zone

Allowsed levels For this 2one: Al
- [ - Medium j ] j Ej @ @

n & minute. If you need more time, click more time required,

) I - ;;gfgr"'its before downloading patentially unsafe ide DLA Applications DLA Links DLA Web Links DOD User External DLA Users
:‘l-': - Unsigned Activei! contrals will not be downloaded tions Agresment

I Enable Protscted flods (requires restarting Iernet Explorer)
customevele. | f oeranievs || [
|t Office MS Office 2007 MS Office 2010 SAP SAP GUI Software
oot ol ones o defaut level o

o [ e | a0 (s ol (= |

Web Apps Adobe Acrobat Pro Adobe X DRU System Excel 2010

T " al

Internet Explorer 8 MS Excel 2010 MS OneNote 2010 MS Outlock 2010 MS PowerPoint MS Publisher 2010 MS Word 2010
2010

Open Save Cancel

ZPM

ﬂl il E & I@ # IP’ E I(' 5?30/2012
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Scroll %, of the way down until you see “ Launching applications and unsafe files”. Select
“Enable”, Select “Ok” and close Internet Explorer:

&

PP intern ; = S—
N falis |ﬁ”i‘ @ Citrix %endipp - Applications X

ing:
- S— =
|| Enable MIME Sniffing -] =
o = nterprise
@ Enable
|| Include oaldisasiangath when uploading files to a server

|| Launching applications and unsafe fles
) Disable
@ Enable
O Prompt
aunching programs and files in spa#AME [ |

Select view: >

O
@ Enable
O Prompt
|| Mawigate windows and frames across different domains
A isahle =
4 ' ol

éTak&s effect after you restart Internet Explorer D
~Reset custom settings

Resst to  [vadium (deFault) - Reset...
o _|

ok || cancel [ el ||

HQ Citrix Team

E

1:14 PM

w8 B @[T
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Appendix C - Instructions for Configuring and Using
Citrix with Mac OS

Note: Currently, Citrix Receiver is not functioning using Mac OS 10.10, Yosemite. Citrixis working

to rectify this situation and will release another version of Receiver that is compatible with Mac OS
10.10.

1. Ensure your systemis updated to the latest software by navigating to the Apple iconin the

upper left hand corner of the screen and select Software Update. Click UPDATE ALL if the
option is available.
Grab File Edit Capture Wir
About This Mac

App Store...

System Preferences...

Dock >

Recent Items >

Force Quit... N#D e Upd

Sleep

Restart...
Shut Down...
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2. Pluginyour CAC reader. Open Finder and navigate to Applications - Utilities > System
Profiler (Mac OS 10.6) or System Information (Mac OS 10.7 or later versions). Select USB in

the left hand pane and ensure that “Smart Card Reader” appears in the right hand pane.

¥ Hardware
ATA
Audio
Bluetooth
Card Reader
Diagnostics
Disc Burning
Ethernet Cards
Fibre Channel
FireWire
Craphics/Displays
Hardware RAID
Memory
PCI Cards
Parallel SCSI
Power
Printers
SAS
Serial-ATA
Thunderbolt
USB

W Network
Firewall
Locations
Modems
Valumes
WWAN
Wi-Fi

¥ Software
Accessibility

Mac
USE Device Tree
¥ USB High-Speed Bus
¥ Hub
Smart Card Reader USB
Internal Memory Card Reader
WEBRCM2046 Hub
Bluetooth USB Host Controller
¥ USB High-Speed Bus
¥ Hub
PTK-840
Built-in iSight
IR Receiver

Smart Card Reader USB:

Product ID: 0x3021

Vendor ID: 0x078b (HID Global GmbH)
Version: 3.02

Speed: Up to 12 Mb/sec
Manufacturer: OMNIKEY AG

Location 1D: 0xfal30000 /5

Current Available (mA): 500
Current Required {mA): 100

EAngeIa‘s iMac » Hardware » USB » USB High-5peed Bus » Hub » Smart Card Reader USB

3. Download CACKey fromwww.militarycac.com/MAC/CACKey_0.6.5_SItoml.pkg.tar.gz. Open

the location where you downloaded the file (typically Downloads) and double -click on it to

extract its contents.

4. Double click the newly extracted .pkg file to begin the installation of CACKey.
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5. Read and acknowledge the first 3 screens by clicking Continue. Click Agree to the software

license terms. Click Install to begin the installation of CACKey. Click Close when the
successful installation window appears.
e Install CACKey for Mac OS X SLtoML

Standard Install on “Applications”

B Introduction

& Read Me This will take 3.5 MB of space on your computer.
o License y Click Install to perform a standard installation of
© Destination Select this soﬂwalre for all users of this computer. .:&II
y users of this computer will be able to use this
@ Installation Type software.
® Installation
AT LLLLL L |
@ Sumimary /1
[LLLL | |I I a
o 1
| Customize | | GoBack | | Install |

6. Download the Mac OS X DoD certificates from https:/remote.dla.mil/help/Certificates.zip.
Click on the downloaded folder to open it.

7. Open Finder and navigate to Applications = Utilities = Keychain Access. Click on the
login Keychain in the left hand pane. Select all the certificates downloaded in the previous
step and drag-and-drop them to the right hand pane of the Keychain Access window. Click
Add once for each certificate if prompted.
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—

| 00 (L Certificates
4> 3 = ERiE Ry | © |[3#%~]| (8~ (Q
FAVORITES Name & Date Modified
33 Dropbox B _DOD_CA-27.cer May 24, 2012 2:28 PM
e DOD_CA-28.cer May 24, 2012 2:28 PM
= All My Flles i DOD_CA-29.cer May 24, 2012 2:28 PM
@ Airdrop B _DOD_CA-30.cer May 24, 2012 2:28 PM
& pata B _DOD_EMAIL CA-27.cer May 24, 2012 2:28 PM
- DOD_EMAIL_CA-28.cer May 24, 2012 2:28 PM
& Desktop DOD_EMAIL CA-29.cer May 24, 2012 2:28 PM
Keychain Access G} angela May 24, 2012 2:28 PM
) #\ Applications
d Click to lock the login keychain. t} Sculpt.avi B rel?_dodroot_2048.p7b May 24, 2012 2:28 PM
~ Keychains I - =
a LayerVault
&' login (£ Laye
& Priva...tedDatak
@ Micr...ertificates
& System
| O systemRoots o

Category
A All ltems
L. Passwords
Secure Notes
EJ My Certificates
7 Keys
L Centificates

&l DOD_CA-28.cer]
[DOD_EMAIL CA-29.cer i)
[DOD_EMAIL CA-30.cer g

3 /

8. Insertyour CAC card into the CAC reader. A newkeychain labeled With your last name
should appear above the login keychain. Select it and click on the padlock icon at the top of
the window to unlock the keychain. The keychain password is your CAC PIN.

Keychain Access

lick to unlock the BOGINSKEY. VALENTYN.1390218644 keychain. L
S K eychains
2] BOGI...0218644 S BOGINSKEY.WVALENTYN.1390218644
ol login Torernd Issued by: DOD CA-30
@ Priva...tedDatak | Expires: Sunday, March 31, 2013 7:59:59 PM Eastern Daylight Time
_ . ) @ This certificate is valid
& Micr...ertificates
& System Name Kind 4 | Expires
System Roots I . BOGINSKEY VALENTYN.1390218644 certificate Mar 31, ;
b =] BOGINSKEY.WALENTYN.1350218644 certificate Mar 31,0
b =] BOCINSKEY.WALENTYN.1380218644 certificate Mar 31, 1
Category =] DOD CA-19 certificate Apr23,:
2 Allltems =] DOD CA-20 certificate Apr23,:
.. Passwords ~| DOD CA-21 certificate Jan 25, 2
~| DOD CA-22 certificate Jan 25, 2
Secure Notes -] DOD CA-23 certificate Jan 25, 2
E] My Certificates -] DOD CA-24 certificate Jan 25, 2
7 Keys ] DOD CA-25 certificate Jan 14, 2
= Certificates ~] DOD CA-26 certificate Jan 14, 2
=) DOD EMAIL CA-19 certificate Apr 23,
- DOD EMAIL CA-20 certificate Apr 23,
= DOD EMAIL CA-21 certificate Jan 25, 2
= DOD EMAIL CA-22 certificate Jan 25, 2
- DOD EMAIL CA-23 certificate Jan 25, 2
= DOD EMAIL CA-24 certificate Jan 25, 2
=) DOD EMAIL CA-25 certificate Jan 14, 2
NOM FAMAN FA_2R rartificata lam 14 2
= + i Cop 22 items
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9. Download the Citrix Receiver from https://remote.dla.mil/help/MacCitrixReceiver.zip. Double-
click on the downloaded file to open CitrixReceiver.dmg. Double-click on Install Citrix
Receiver.pkg to beginthe installation.

B Citrix Receiver

Install Citrix Receiver.pkg Uninstall Citrix Receiver

10. Click Continue to acknowledge the security prompt. Click Continue to acknowledge the
next two windows, then click Agree to the software license terms, and then click Install,
entering your password if prompted. Click Close to dismiss the successful installation
window. Drag the original .dmg file to the trash can to eject the image.

B |nstall Citrix Receiver

Standard Install on “Applications”

& Introduction
& License This will take 62.3 MB of space on your computer.

© Destination Select Click Install to perform a standard installation of
. el W T

@ Installation Type this software on the disk "Applications”.

@ Installation

® Summary

[ ]
CITR!X | GoBack | | Install |
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11. Open a new Safari window, open Safari’'s Preferences by selecting Safari >Preferences
from the Safari’s tab menu. Click the ‘Advanced’ tab labeled. Place a check mark next to
‘Show Develop menu in menu bar.’

12. Make sure to quit any previous instances of Safari. Open a new Safari window, click the
Develop tab-> click on User Agent and select Internet Explorer 8.0. Navigate to
https://remote.dla.mil. Click | Agree With The Statements Above and click LOGIN on the
following page. Select your E-mail certificate whenever prompted to authenticate, as many
times as necessary (this should only occur the first time). If you get an authentication error,
ensure the CAC keychain is unlocked in Keychain Access.

P The website “gslb.dla.mil” requires a client certificate.

al This website requires a certificate to validate your identity. Select the
o ; 3 - ;
,Eéﬁé} certificate to use when you connect to this website, and then click
—ar Continue.

-/ BOGINSKEY.VALENTYN.1390218644
- BOGINSKEY.WALENTYN.1390218644 (DOD EMAIL CA-30)

( ?‘ ) Show Certificate Cancel Continue

13. Click on any application to launch it. Enter your PIN again when prompted. The setupis now
complete. (Note: If CAC card is removed from the CAC Reader or the Citrix Session times out,
repeat steps 12 and 13)
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Appendix D — Approved Smart Card Readers

Supplier |
Cherry Electrical Products
Cherry Electrical Products
Cherry Electrical Products
Cherry Electrical Products
Dell Inc

Dell Inc.

Dell, Inc

Dell, Inc.

Dell, Inc.

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Corporation

HID Global Corporation
HID Global Corporation
HID Global Corporation
HID Global Corporation
HID Global Corporation

HID Global Corporation

HID Global Corporation
(formerly Omnikey
Americas)

Product Name

Cherry Smart Terminal ST-1044U

Cherry Smart Reader SR-4044

SR-4300 ExpressCard Smart Card Reader

ST-1210 SmartTerminal Smart Card Reader (XX1X)
Dell External USB Keyboard with Smart Card Reader

Broadcom USH2 Smartcard Solution

Broadcom USH Smart Card Solution

Dell Latitude D430, D630,D830 w/ 02 Micro Smart Card
Dell External USB Keyboard with Smart Card Reader

iCLASS RK40

iCLASS OEM150

iCLASS RPK40

iCLASS RKL550

iCLASS RK40

iCLASS RPK40

iCLASS RMK40

iCLASS RMPK40

Omnikey 5321 USB Smart Card Reader
Omnikey 5321 CRUSB Smart Card Reader
Omnikey 5321 CL SAM USB Smart Card Reader
iCLASS RMP40

iCLASS RM40

iCLASS RP40

iCLASS R10

iCLASS R15

iCLASS R30

iCLASS RP15

iCLASS R40

Omnikey 4321 ExpressCard SmartCard Reader

| Part Number
ST-1044UB

SR-4044

SR-4300
ST-1210UAX-x
SK-3205

BCM5882

BCM5880

OZ77CR6

RT7D60
6130BKNO0O0000-G3.0
3121BNNO000-G3.0
6136AKN000000-G3.0
6170BKT000000-G3.0
6130CKNO00000-G3.0
6136CKNO00000-G3.0
6230CKNO00000-G3.0
6236CKNO000000-G3.0
Omnikey 5321
Omnikey 5321 CR
Omnikey 5321 CL SAM
6225CKNO0000-G3.0
6220CKNO0000-G3.0
6125CKNO000-G3.0
6100CKNO000-G3.0
6140CKNO000-G3.0
6110CKNO000-G3.0
6145CKNO000-G3.0
6120CKNO0000-G3.0

Omnikey 4321

Lenel Systems
International

LNL-3121

LNL-3121

Lenel Systems
International

Lenel OpenCard PIV Reader XF1100-PIV

LNL-XF1100D-PIV

Lenel Systems
International

Lenel OpenCard PIV Reader XF2100-PIV

LNL-XF2100D-PIV
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Lenel Systems
International

SCM Microsystemsinc

SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.
SCM Microsystems, Inc.

SecuGen Corporation
XceedID Corporation
XceedID Corporation
XceedID Corporation
XceedID Corporation
XceedID Corporation

XceedID Corporation

Citrix Home User Guide

Lenel OpenCard PIV Reader XF2110-PIV

SCR3500 USB Smart Card Reader
SCR331 USB Smart Card reader
SCR243 PCMCIA S/C Reader
SCR3310 USB Smart Card Reader
SCR3311 USB Smart Card Reader
SCR131 Serial Port S/C Reader
SCR531 Serial/USBS/C R/W
SCR333 Drive Bay USB SC Reader
SCR3340 ExpressCard 54 SC Reader
SDI010 Contact/ContactlessSmart Card Reader
PAT1312 Physical AccessReader
PAT 1322 Physical AccessReader
SCR338 Smart Card Keyboard
SCR3310v2

PAT1241

SCR339

SCR3310

SCR3311V2

SCR333V2

SecuGen iD-USB SC/PIV

Multi-Tech Wallmount Reader
Multi-Tech Wallmount RS485 Reader
Single-Frequency Mid-Range Keypad Reader
Single-Frequency Mid-Range Reader
OEM Module

Single-Frequency Mullion Reader

LNL-XF2110D-PIV

905141
SCR331
SCR243
SCR3310
SCR3311
SCR131
SCR531
SCR333
SCR3340
SDI010
904565
904566
903720
SCR3310v2
904322
905174
905185
905194
905195
EA4-0516B
XF1500P
XF1500CS4
XF2210
XF2200
OEM100
XF1200
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Appendix E — How to Map a Network Shared Folder

Citrix users will be able to map a network shared folder by following the instructions below:

Note: In order to map a network shared folder, you will need the following information:

\\Server\Share

1. Server is the name of the server that is hosting your share. You will need to get this from

your site IT resource

2. Share is the name of the folder that is assigned to store your personal information. This

information also needs come from your site IT resource

Do not attempt to complete the following instructions without the above infor mation as you will be

asked for your Server and Share in the following dialogue boxes.

1. Launch Windows Explorer from the Citrix Application Web Interface:

7 P
@ LS ) N of P P
( i | = ) 1
Intermnet Explorer 8 M5 Excel 2010 MS Office M5 OneMote 2010 MS Outlook 2010 M5 PowerPoint M5 Publisher 2010
Communicater 2010
I r
w @g e M m @ B
— — gt
M5 Word 2010 Qcs QUTLOOK 2010 PowerPaint 2010 RDP Client Remedy 76 Save Certs
— P
S wi
-J_—l_-IJ
ZW/indows Explorer Weord 2010
H “ H ”»
2. Click “Map network drive
(_}\_} [="~ Computer = g ~ 23 [ search Computer Bl
Organize ~  Properties  System propertied] Map nﬂwor@ B - @
¢ Favorites + Netwark Location (4
Bl Desktop
18 Downloads
i Libraries
[ Dacuments
& Music
=) Pictures
B videos
18 Computer
# APPS (\\BEL15-1112
5 GLOBAL (WBEL1S-11
55 HCSAL10 (\Bells-11
% DLASHARE (\\BEL1S
GLOBAL (\\BEL15-1111) (G) Spaccusec: NN 1 Totalsize 121 7B
: Network Drive Space free: 509 GB File system: NTFS
-
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3. Click the drop down on the “Drive” field and select your drive letter. You can select any drive
letter that is not in use. “H’ is letter used at DLA to represent a user’s (H)ome folder. Select the
dropdown boxon the Folder field until you see your server and folder name appear. Select your
server and folder then checkthe boxto reconnect the next time you log in so that you do not have
to repeat this process. Click Finish to complete the Map Network Drive process.

‘f, Map Metwork Drive |

-
&5 q:_'_\. Map Metwork Drive

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Dirinves IE: j
Folder: I j Browse... |

Examnple: \\serverishare

[¥ Reconnect at logon
[T Connect using different credentials

Connect to a3 Web site that vou can use to store vour documents and pictures,

Eirish Cancel
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Appendix F — Instructions for Configuring and Using
Citrix with Internet Explorer 11

Internet Explorer version 11 (IE 11) is not compatible with CAC authentication to
https://remote.dla.mil without changing default settings described in this appendix. If either one of
the following two screens are displayed, check which version of IE you are running.

1. Youreceive the following username/password authentication page instead of the typical
DoD CAC PIN authentication page:

- . - - - o
o@@hﬁps:,’/gslb‘dla‘miI"C\(r'wx/CAC/aulh,’\ugin‘aspx P a0|@cixentpp-logn U A
x @hoton @577 1@ i A
B v B v @ v Pagev Safetyv Tookv @ &

Citrix XenApp

Username:
‘ ' Password:
Domain:

X There are no authentication methods
currently available,

2. You receive “This page can’t be displayed” page:

e( _\| @ https://gslb.dla.mil/Citriz/ CAC P~ || (& This page can't be displayed % | |
- - [ deh v Pagev Safety~ Tools~ @@~ € [0 o O

This page can't be displayed

* Make sure the web address https://gslb.dla.mil is correct.
* Look for the page with your search engine.

* Refresh the page in a few minutes.

| Fix connection problems |
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Select the white gear “Tools” icon in the far upper right-hand side of the page — it will turn blue
when selected. Select “About Internet Explorer” to confirm IE 11 is the browser version installed on

your computer.
—- — TS

QV\@ hitps://remote dia.mil/ £ - @ || @ pLaknterprise Remote Ace.. x || i 23@
- [ @@ v Pagev Safety~ Toolsv @~ il i
File ,
Zoom (100%) ,
Safety ,
+«DEFENSE LOGISTICS AGENCY Add site to Start menu
Tho Warfightersioyl&tics Combat Support Agency View downlasds Ctrle)

¥

g 4

¥ W Manage add-ons
{1111E

You are accessing a U.S. Government (USG) Information System (IS) that is provided for USG-authorized

use only.

F12 Developer Tools

Go to pinned sites
Compatibility View settings

By using this IS (which includes any device attached to this IS), you consent to the following conditions: e

-The USG routinely intercepts and monitors communications on this IS for purposes including, but not
limited to, penetration testing, COMSEC monitoring, network operations and defen: onnel
(PM), law AF\ and

About Internet Expl
-At any time, the USG may inspect [— =

PR
o g o o Internet

L — Explorer1
not for your personal benefit or priv

; s 2 Version: 11.0.9600.16428
~Notwithstanding the above, using Update Versions: RTM (KB2841134)
searching or monitoring of the cont Product ID: 00150-20000-00003-AA459
representation or services by attos ~
communication and work product & [ Install new versions automatically

© 2013 Microsoft Corporation. All rights reserved.

If you are NOT running IE 11, followthe instructions (pictured below) from https://remote.dla.mill:
“If this is your first time accessing this system from this machine...” or “Still not working? Try the

following...”

DLA Enterprise Remote Access Syst

Eu/Afr Login LOGIN Pacific Login

Note: VDI LOGIN will be available to Phase 1 VDI users only

Q If this is your first time accessing this system from this machine, you may need to

install the following to log in:

* DoD Root Certificates
o Windows
o Mac OS5
e Citrix Receiver
o Windows
o Mac OS5

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.352.0001
to request the software and a CAC reader.

q Still not working? Try the following:

e Close all browser windows and try again.

« Confirm you are selecting your DoD EMAIL certificate when logging in.

« Review the Home User Guide.

« For issues with multiple PIN prompts, make sure you have installed
ActivClient (including the latest Hotfix) from the links above.

« Known Internet Explorer 11 issue: If asked to enter your "Username and
Password" instead of DoD CAC PIN, complete the following two steps: In
Internet Explorer Options > Security Tab, add https://*.dla.mil to "Trusted
Sites"; In Internet Explorer > Tools > Compatibility View Settings add dla.mil
to "Compatibility View".
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If you are running IE 11, followthe instructions below from https://remote.dla.mill:  “Known
Internet Explorer 11 issue:” You will need to complete the following two steps.

DLA Enterprise Remote Access System

Ew/Afr Login LOGIN Pacific Login

Note: VDI LOGIN will be available to Phase 1 VDI users only

VDI LOGIN

If this is your first time accessing this system from this machine, you may need to
install the following to log in:

+ DoD Root Certificates
o Windows
o Mac 05
+ Citrix Receiver
o Windows
o Mac 05

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.252.0001
to request the software and a CAC reader.

still not working? Try the following:

Close all browser windows and try again.
Confirm you are selecting your DoD EMAIL certificate when logging in.
Review the Home User Guide.
For issues with multiple PIN prompts, make sure you have installed
ActivClient (including the latest Hotfix) from the links above.

+ Known Internet Explorer 11 issue: If asked to enter your "Username and
@ Password" instead of DoD CAC PIN, complete the following two steps: In

Internet Explorer Options > Security Tab, add https://*.dla.mil to "Trusted

Sites"; In Internet Explorer > Tools > Compatibility View Settings add dla.mil
to "Compatibility View".

Step 1: Select the white gear “Tools” icon in the far upper right-hand side of the page — it will turn
blue when selected. Select “Internet Options”

Print »
DLA Enterprise Remote Access System File 3
Foorm (100%:) 3
Safety »

Eu/Afr Login LOGIN Pacific Login

Note: VDI LOGIN will be available to Phase 1 VDI users only

If this is your first time accessing this system from this machine, you may need to
install the following te log in:

Add site to Start menu

Wiew dowenloads Ctrl+]
Manage add-ons

F12 Dewveloper Tools

Go to pinned sites

Compatibility iew settings

Report website problems
= T T —
About Internet Explarer

+ DoD Root Certificates
o Windows
o Mac 0S5
« Citrix Receiver
o Windows
o Mac OS5

A CAC Reader and the ActivClient Software will be provided by your local IT
Support staff. Please contact the Enterprise Help Desk at 1.855.352.0001
to request the software and a CAC reader.

Citrix Home User Guide Page 46


https://remote.dla.mill/

Select the “Security” tab. Then select “Sites”

m Internet Opticns

i ™
GEHEFE'I Security |BPrivacy I Content I Connections | Programs | ndvanoed|

- e

| General | Security |Pri~wac5-I I Content I Connections I Programs | Advanoed|

Internet Opticns

Home page
l/) To create home page tabs, type each address on its own line.
&

| -

-

[ Use current ][ Use default ” Use new tab

Startup
() Start with tabs from the last session
@ Start with home page

Tabs

Change how webpages are displayed in tabs.

Browsing history

Delete temporary files, history, cookies, saved passwords, and web
form information.

|| Delete browsing history on exit

Select a zone to view or change security settings.

@ & v O

Internet  Local intranet I ERIEY  Restricted
sites

Trusted sites

This zone contains websites that you
trust not to damage your computer or
your files,

You have websites in this zone,

Security level for this zone

Allowed levels for this zone: Al

Medium
- Prompts before downloading potentially unsafe

. content

- Unsigned ActiveX controls will not be downloaded

["1Enable Protected Mode (requires restarting Internet Explorer)

’ Delete. .. ][ Settings ] ’ Custom level... ][ Default level ]
Appearance ’ Reset all zones to default level ]
Colors ] [ Languages ] [ Fonts ] [ Accessibility ]
[ OK ] [ Cancel ] ’ Apply QK I [ Cancel ] ’

“Close”

Enter https://*.dla.mil (“*” asterisk; followed by a “.” period; then dla.mil). Select “Add” then

-

Trusted sites

O ——

[t

Add this website to the zone:

) You can add and remove websites from this zone. All websites in
g this zone will use the zone's security settings.

hittps://*. dla.mill

Websites:

https: /f*.dla. mil

Remove

Require server verification (https:) for all sites in this zone

 Ces= ]
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Select “Apply” then “OK”
r]nifr_zel QOptions M‘

| | General | Security |Privacy I Content | Connections I Programs. I ndvanced|

Select a zone to view or change security settings.

@ & v O

Internet  Localintranet QIVEERETES  Restricted
sites

Trusted sites

This zone contains websites that you
trust not to damage your computer or
your files,

You have websites in this zone.

Sites

Security level for this zone
Allowed levels for this zone: Al

Medium
- Prompts before downloading potentially unsafe

:l content

- Unsigned ActiveX controls will not be downloaded

[ Enable Protected Mode (requires restarting Internet Explorer)
[ Custom level... ] [ Default level ]

[ Reset all zones to default level ]

OK Cancel Apply

Step 2: Select the white gear “Tools” iconin the far upper right-hand side of the page — it will turn
blue when selected. Select “Compatibility View settings”

f@\Windows\TemporaryIntemet iles\e © = @] © oL Enterprise Remote Acc..

Defense Logistics Agency

Print
File

DLA Enterprise Remote Access System e
Safety

Add site to Start menu
Eu/Afr Login Pacific Login View downloads

Manage add-ons

Note: VDI LOGIN will be available to Phase 1 VDI users only F12 Developer Taols

VDI LOGIN Go to pinned si

Compatibility View settings

.If this is your ﬁr?t time BCEIZBSSiI'Ig this system from this machine, you may need to Report website problems
install the following to log in:
Internet options
+ DoD Root Certificates
= Windows
= Mac OS5
* Citrix Receiver
- Windows
= Mac 05
* ActivClient
= 32-bit
= Base Install
= Latest Hotfix
= 64-bit
= Base Install
= Latest Hotfix

About Internet Explorer
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Enter “dla.mil” select “Add” then “Close”.

= &
Compatibility View Settings X
|
l/_\ji] Change Compatibility View Settings
[
Add this website: pme—
dia. mil [ add ]
¥
Websites you've added to Compatibility View:
dla.mil Remaove

Display intranet sites in Compatibility View
[ use Microsoft compatibility lists

Learn more by reading the Internst Explorer privacy statement

o )
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